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Likno Web Accordion Builder
The Complete Tool for Creating Powerful Web Accordions
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Likno Web Accordion Builder is a user-friendly interface (GUI) to the popular jQuery open source library, that
allows you to create stylish, feature-rich jQuery accordion & slider controls for your web pages, with minimal
effort and coding.
All the jQuery accordion & slider controls it creates are cross-browser and work alike in all browsers.
The present manual will assist you in taking the most out of this software.
The Likno Software team
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Introduction

1.1

What is Likno Web Accordion Builder

2

Create Web Accordions in 5 easy steps!
Likno Web Accordion Builder is an application that serves as an interface to the popular jQuery
open source library, allowing you to create various "HTML Accordions" for web pages with minimal
effort and coding.
It creates cross-browser jQuery accordions that work alike in all browsers.
Through our builder you can easily create web accordions with many options, like showing content
added easily through the interface (embedded), external or internal (AJAX) pages, and more.
The produced accordions are fully cross-browser, i.e. they work alike in all browsers supporting
DHTML (like Firefox, Internet Explorer, Google Chrome, Opera, Mozilla, Konqueror, Safari and more).
Likno Web Accordion Builder will save you a significant amount of time and effort required to fully
understand DHTML and Javascript code capable to support all browsers for creating powerful web
accordions!

View the complete properties listing for more info.

1.2

What's new
Please check the new features, enhancements and fixes of the application by visiting the following
page online:
http://www.likno.com/jquery-accordion/whatsnew.php

1.3

Terminology
Accordion Project
Each project produces a single accordion control. For separate accordion projects (accordion controls)
within the same page, read more information here.
Accordion Control
Your entire project is an accordion control:
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Accordion Container
This is the area that contains all panes of the container (their "headers" and "bodies"):

Panes
A "pane" consists of a "Header" and a "Body". The open panes show both, the closed panes show only
their Header:

© 2000-2014 Likno Software, all rights reserved

Introduction

Pane Headers
This is the area that selects/deselects each "pane" in the accordion:

Pane Bodies
This is the area that shows the actual content of each "pane" in the accordion:
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Pane Content
The "content" of a pane is the information that displays in both its "Header" and "Body". This content
can be from a simple text, to rich HTML content, and even a whole new page derived either as an
AJAX call or as an external website.
More information here.
Project Style
The style of the accordion is its appearance (colors, background, borders, etc.) and behavior
(opening/closing effects, etc.).

1.4

About Likno Software
Likno Software is a software development company dedicated to creating quality software for
demanding web authors. Our development team is 100% internet-oriented, focused on creating tools
that minimize your web development efforts.
For detailed technical support you can access the following URL:
http://www.likno.com/support_page.html
For sales questions you may contact us at sales@likno.com.
Our web site is located at http://www.likno.com
Note: In case you came here to find your Installation ID, it can be found at the "Help -> Enter
Activation Code" command of the application menu, as shown below:
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An Accordion in 5 easy steps

2.1

Step 1: Select the content and properties of the accordion

8

Step 1
In the <Project Panes> tab you can find all the content properties for each "pane" of the accordion
individually (i.e. "header" and "body" of each accordion pane).
All properties are described and explained in the "Properties" help section.
Note: If you choose the UL/LI or DIV population option, don't forget that you should also add the UL/LI
elements or DIVs in your actual web page!

2.2

Step 2: Select the Project Style of your accordion
Step 2
In the <Style Editor> tab, choose the style properties that will apply to the accordion container, the
panes, the "header" and "body" of each pane in the accordion, and more.
All settings are described and explained in the "Properties" help section.

2.3

Step 3: Compile and Link the Project
Step 3
Compile:
Click on the "Compile" button and select the location where you want to save your compiled JavaScript
files.
Link:
Once you have compiled your project, use the "Link" button to retrieve the necessary code that must
be added to your pages in order to link the compiled files to them.
Make sure that the correct path to the source javascript file has been used, otherwise the accordion
will not appear.

2.4

Step 4: Upload the files to your server
Step 4
Once you have compiled and linked your compiled javascript project to your pages, you will need to
upload the files to your web server. The files created by Likno Web Accordion Builder during the
compilation phase are:

© 2000-2014 Likno Software, all rights reserved
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./likno-scripts/

(folder)

./likno-scripts/likno_accordion_project.js *
./likno-scripts/likno_accordion_lib.js
./likno-scripts/jquery.js
./likno-scripts/likno_accordion_project/
(all image files used by the accordion)

* (folder)

where "./" is the "Site_Root" folder (also specified in Project Properties).
(* the highlighted names may be different if you changed the "Compiled Javascript Project" name in
Project Properties)
All these files and folders have to be uploaded to your web server using your favorite FTP tool. Make
sure that the directory structure is kept exactly the same as is displayed here and also pay careful
attention in order to keep the same case for the files when they are uploaded. You have also to make
sure that the files are placed in the same location relative to your HTML files as they are locally, in
order for the directories that were set while linking your compiled project locally to point to the right
structure on your web server.

2.5

Step 5: Save your work
Step 5
Your Web Accordions can be saved in a .lwac project file so that you can use/edit it in the future. Just
use 'Project->Save' or 'Project->Save As' for this process.
Once your file is modified you will need to compile it again (but not link it) and upload the new
likno_accordion_project.js file to your web server. The likno_accordion_lib.js file needs to be
re-uploaded only if you re-compile your project with a newer Likno Web Accordion Builder version
(since it may use an updated engine).

© 2000-2014 Likno Software, all rights reserved
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3

User Interface

3.1

Main window layout
Likno Web Accordion Builder uses several tabs:

Project Panes tab (F2)
Here you can add panes ("Headers" and "Bodies") to your accordion, specify their content, the
accordion's positioning and more.

Style Editor tab (F3)
Here you can modify the style properties of the accordion of the loaded project.

Sample Code tab (F4)
Here you can view sample HTML code that shows the accordion in the Preview Pane, so that you
understand what code needs to be added to your own pages.

Preview tab (F5)
Here you can preview the accordion that you have specified in the "Project Panes" tab.

Project Properties tab (F6)
Here you can specify the compiled files and folders of the project, as well as the domain for which
the project should be licensed and functional.

3.2

Keyboard shortcuts
There are several shortcuts defined for quicker access to frequently used functions:
· F1
Provides context sensitive help for each property
· F2
Opens the Project Panes tab
· F3
Opens the Style Editor tab

© 2000-2014 Likno Software, all rights reserved
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· F4
Opens the Sample Code tab
· F5
Refreshes and opens the Preview tab
· F6
Opens the Project Properties tab
· Ctrl + F12
Opens the Compile dialog
· F8
Compiles the project without any dialogs
· Shift + Ctrl + F12
Opens the "Link Compiled Project to Web Pages" dialog
· Ctrl + N
Creates a new project
· Ctrl + O
Opens a .lwac project
· Ctrl + S
Saves the selected project

© 2000-2014 Likno Software, all rights reserved
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Commands

4.1

Command: Project
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New
Creates a new Likno Web Accordion project.
Open
Opens a Likno Web Accordion project.
The Likno Web Accordion files are found under the .lwac extension.
Save
Saves the selected project into a *.lwac file.
Save As
Saves the current project with a different filename.
Save All Projects
Saves all loaded projects, but not the examples which are read-only.
Close Selected Project
Closes the selected project.
Close All Projects
Closes all loaded projects, but not the examples which are always available.
Export Project
Exports the loaded project as a ZIP file in order to move it to other PCs without having problems with
the file paths of the linked images (the "assets" folder).
Exit
Closes the Likno Web Accordion Builder application.

4.2

Tools

4.2.1

Command: Compile Project
Compiles the .lwac project into a .js file that has to be linked to your web pages.
To use an accordion in your web pages you must take the following four steps:
Step 1. Compile the project

(note: spaces are not allowed in filename)

Step 2. Link the compiled project to your web pages
© 2000-2014 Likno Software, all rights reserved
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Step 3. Upload the necessary files and folders (see a description of these elements below)
Step 4. Upload the web pages that contain the project link
(note: steps 2 & 4 are not necessary if you have already linked the project to your web pages and you only want to update
your accordion)

How it works:
When compiling a project as likno_accordion_project.js, the following elements are created inside
the same directory:
1. The core likno_accordion_project.js javascript file.
2. The "Compiled Libraries" and "Compiled Images" folders as defined in Project Properties.
It is critical that you do not forget to upload the /likno-scripts directory, where these files are
compiled.

See also
Link Compiled Project to Web Page(s)

4.2.2

Command: Link Compiled Project to Web Pages
Links a compiled project (.js file) to a selection of web pages.
At this stage, the application inserts the necessary "Linking Code" into the selected web pages. No
DHTML or Javascript knowledge is required since the whole process is performed by the application.
The link is a few lines of code and can be easily identified inside the source code by a related
comment.
The linking process requires only two pieces of information:
1. The compiled project file (eg: likno-accordion-project.js)
2. The web page(s) where the link will be added.
Obviously, you need to upload the updated web pages on the server so that the accordion can be
viewed on-line. However, it is important that you also upload:
1. the compiled project file (eg: likno_accordion_project.js)
2. the "/likno-scripts" folder
3. the "/likno-scripts/likno_accordion_project" folder if you use images. Your folder may be different
depending on the name you choose to use for the compiled project file.
Upload the above at the same directory structure where they reside locally.
See the Compile Project command for more info on this issue.

To update the design of an already compiled project you should first make the changes to its
© 2000-2014 Likno Software, all rights reserved
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respective .lwac file and then recompile it. Provided that you did not change the name or the directory
of the compiled project, you do not need to re-link the project to the pages that already contain that
link.
Notes:
Note about file extensions:
The link can be inserted in any kind of page, regardless of its extension. Just use the All Files (*.*) filter
to select web pages that have an extension other than the typical .html or .htm one.
Note for Dreamweaver users:
If you like, you can also link the compiled project to a template (.dwt) or a library (.lbi). Just select the
related directory (Templates or Library) and use the All Files (*.*) filter so that you can view the
template or library file.
The library (.lbi) is a special Dreamweaver file containing a collection of individual assets or copies of
assets that you can place in your web pages. That means the linking code can be added in a library
but you should make sure that the library should be placed as the first element after the BODY
opening tag (<body>) and that the linking code is the first element, listed in the library file itself.
The project does not have to be compiled inside the Templates directory. On the contrary, we do not
advise you to do so as you will have to upload the Templates directory on the server too.
Note for FrontPage users:
Similarly to Dreamweaver, you can link your project into an include so that it can be used by all other
pages. Just make sure that this include contains only the project and that it is inserted immediately
before the </body> tag of the pages.
Similar techniques can be used with other web authoring tools too.
See also
Compile Project

4.2.3

Command: Project Properties
Allows you to specify the following properties and settings for your loaded project:
Compile Properties
Preview Panel Settings

4.2.3.1

Compile Properties
Allows you to specify the following compile properties and options for your loaded project:
The Site_Root folder is the location where your web site (your main index page) is locally stored.
It is also referred as the "Site Root" folder in other applications. It is very important that you specify the

© 2000-2014 Likno Software, all rights reserved
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correct folder here as it is used in the compile process.

The Compiled Javascript Project is the javascript file generated when you compile your
project. It defaults to likno_accordion_project.js but you may as well change it to something else. Note
that you can use multiple accordions in the same website by having different projects compiled using
different "Compiled Javascript Project" names.
Once you setup your "Site_Root folder", you are able to edit the "Compiled subfolders":

The Compiled

Libraries subfolder (default: \likno-scripts) which contains the following:

likno_accordion_lib.js The required Javascript accordion-building Libraries. These are the
javascript files containing all the functions that build the accordion and drive
its behavior.
likno_accordion_project.js

The compiled project file (actual name depends on your settings)

There is no apparent reason to change the libraries folder, so we recommend that you keep the
default value.

The Compiled Images subfolder (default: \likno-scripts\likno_accordion_project) which
contains any image files used by your accordion. If not uploaded, the accordion will show no images.
The missing image sign ("x") may also appear in place of those images.
Custom folders may be required when two or more different accordion projects are used in the same
website and images from both projects use the same names. This is the usual situation that may
require you to have a different subfolder for the produced images.
Custom folders may contain relative paths too (eg: ../). If you do so, the folder location will be
relative to the location of the compiled likno_accordion_project.js file.

The Domain (website) where the compiled project will be used is very important as it
affects whether your accordion is available to your online visitors or just you (for testing purposes).
You can always view (test) your accordion by using a localhost or numeric IP on the browser but not
when using a "letter-based" domain (eg:www.fifa.com), unless you have purchased a domains
license and allocated a domain to that license.
For example, "fifa.com" uses the "83.231.250.129" numeric IP.
(find the numeric IP of any domain name here: http://www.hcidata.info/host2ip.cgi)

FIFA developers could then test their accordion using any of the following:
c:/portfolio/fifa_site/page.html

(local hard drive)

© 2000-2014 Likno Software, all rights reserved
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http://localhost/page.html

(localhost)

http://83.231.250.129/page.html

(their numeric IP)
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But their actual visitors could not view the accordion when using the respective "letter-based" domain:
http://www.fifa.com/page.html

(domain)

So, what FIFA could do is purchase the "3-Domain" license, allocate "fifa.com", get an Activation
Code and choose to compile for the "fifa.com" domain. Or simpler, purchase the "Unlimited
Domains" license, get an Activation Code and just compile for ANY domain. Any of these 2 options
would make the accordion available for the "fifa.com" online visitors.
Note on "subdomains": Do not allocate subdomains, just allocate their major domain, as 10 of its
first-level subdomains will be supported by default (examples: "subdomain.fifa.com", "
subdomain2.fifa.com", but not "sub.subdomain.fifa.com"). For more than 10 subdomains
(or second-level subdomains) on the same domain, you need to purchase the "Unlimited Domains"
License.

4.2.3.2

Preview Panel Settings
Allows you to specify folders so that the Preview Panel can show images (if used) that are relative to
the page or site root.

© 2000-2014 Likno Software, all rights reserved
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While these images will show online (on the actual site), the local Preview Panel cannot show them,
unless you specify local folders to browse from.
For previewing purposes, the Preview Panel locates graphics on the disk by searching for files in the
directories in the "Image Folders for Preview Panel" list.
By default the "Project Assets Folder" and the "Application Gallery Folder" are included in the Image
Folders list so that any images in those folders will be found automatically. You cannot remove them
from the list.
Please note that you must be careful to avoid duplicate graphics file names in different folders
(the standard folders or yours). If this occurs, the 1st match will "win" depending on how the order of
folders is (use the "move up/down" buttons to determine the priority of folders).

4.3

Command: Help
Contents
Displays the contents of the help file. It also supports both keyword and full-text search.
Purchase
Transfers you online, to the order page.
Enter Activation Code

© 2000-2014 Likno Software, all rights reserved
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This is where you can enter an Activation Code. You will receive this Activation Code through your
Likno User Area account which is created after your purchase of a license for the application.
Visit Likno on the Web
Visit our web site to contact us, get the latest information on new versions and products.
Check for Updates
Checks if newer versions have been released since the last time you installed the application.
It is recommended that you check for updates frequently as we regularly release improved
cross-browser support for your implementations.
About
Displays the About box of Likno Web Accordion Builder, with your license information.

© 2000-2014 Likno Software, all rights reserved
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Properties are classified in the following categories:
The Project Panes properties, which specify the content (panes) and the positioning of the accordion
of the loaded project:
Accordion Populated By
Header Source
Body Source
Positioning

(Project, UL/LI structure, DIVs)
(for each pane of the accordion)
(for each pane of the accordion)

The Project Style properties, which specify the appearance and behavior of the accordion of the
loaded project:
Accordion Behavior
Initial Open Panes
Pane Orientation
Panes Show/Hide - How
Panes Show/Hide - When
Accordion Container (Width/Height/CSS)
Panes (Width/Height/CSS)
Pane Headers
Pane Bodies

5.2

"Project Panes" Properties

5.2.1

Accordion Populated By
This is where these options are located:

1. Accordion is populated by the project itself.
This means that you add/edit all panes of the accordion, along with their header content and body
© 2000-2014 Likno Software, all rights reserved
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content inside this application. The compiled project contains all information: the number of panes
and their content, as well as the style and positioning preferences.
2. Accordion is populated by a UL/LI structure, located inside your page.
This means that you add/edit all panes of the accordion, along with their header content and body
content NOT inside this application but inside your online page where the accordion is to be
located. The compiled project contains only the style and positioning preferences but the actual
data on the number of panes and their content is retrieved by a UL/LI structure that you add and
edit inside your page.
3. Accordion is populated by DIV elements, located inside your page.
This works exactly like the UL/LI option above, with the difference that you use DIV elements to
specify the panes and their content on your page, instead of the UL/LI structure.

Note about "image-based headers" when using the "UL/LI structure" or "DIV elements"
population method:
You can also use 4 images for the 4 different states of a single image header, if you just put their tags
at the beginning of the element and next to each other:
<li>
<img src="lwac_image_header_closed.png" width="150" height="140">
<img src="lwac_image_header_closed_over.png" width="150" height="140">
<img src="lwac_image_header_open.png" width="150" height="140">
<img src="lwac_image_header_open_over.png" width="150" height="140">
</li>
OR
<div class="liknoaccordion_header">
<img src="lwac_image_header_closed.png" width="150" height="140">
<img src="lwac_image_header_closed_over.png" width="150" height="140">
<img src="lwac_image_header_open.png" width="150" height="140">
<img src="lwac_image_header_open_over.png" width="150" height="140">
</div>
OR (both image and text)
<div class="liknoaccordion_header">
<img src="lwac_image_header_closed.png" width="150" height="140">
<img src="lwac_image_header_closed_over.png" width="150" height="140">
<img src="lwac_image_header_open.png" width="150" height="140">
<img src="lwac_image_header_open_over.png" width="150" height="140">
Header Text here...
</div>

© 2000-2014 Likno Software, all rights reserved
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Header Source options
This is where these options are located:

Read more for these options on how to specify the content of an accordion:
Is Separator
Embedded
Image

5.2.2.1

Is Separator
A pane can act as a separator between its adjacent panes, when the following option is used in
"Project Panes" for its header:

A separator does not have any "mouse over/click" effects, neither "body content", as it is there to
provide separation or "title" support.
For example in "Example 01", if you make "Pane_2" a separator you will get a "separating area" like
this:

© 2000-2014 Likno Software, all rights reserved
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The combo box next to the "Is Separator" option provides some standard content to show.
The most important option is the last one: <Custom: Use Header values below>
This means that you can show anything you like by specifying it in the Header Embedded or Image
properties.
Note: Through the Pane Headers Separator CSS, your "separator" headers can differentiate their
appearance from "normal" headers. Also, if you use content on your separators you may want to adjust
the "height" (or "width") through that CSS property, otherwise the content may be partially visible if the
"height" or "width" is small. The same applies when you use a "Background Set" in Style Editor.
See also
Header Source options
Pane Headers Separator CSS

5.2.2.2

Embedded (for header)
Add the content of the pane header directly into the "Text/HTML" property.
You can either add simple text to be displayed, or more complex HTML code.
Notes:
- The paths of any files (images, etc.) used inside the HTML should be relative to the location of the
web page that shows the accordion. read more
- For the Preview Panel to be able to show images using Site_Root-relative paths (example:
"/image1.gif") or Page-relative paths (example: "image1.gif" or "pics/image1.gif"), you need to add
them to the "Project Assets" folder or to any other local folder that you specify through the Image
Folders for Preview Panel list in Preview Panel Settings.
See also
Header Source options
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Image (for header)
The content of the pane header is an image.
You can also specify a different image to show on the 4 different states:
"Pane Closed" state
"Pane Closed - Mouse Over" state
"Pane Open" state
"Pane Open - Mouse Over" state
The image can be sourced either from the project's "Assets" folder, the application "Gallery" folder or a
web location (relative or absolute to the loaded page).
Note when using the "UL/LI structure" or "DIV elements" population method:
You can also use 4 images for the 4 different states of a single image header, if you just put their tags
at the beginning of the element and next to each other:
<li>
<img src="lwac_image_header.png" width="150" height="140">
<img src="lwac_image_header_o.png" width="150" height="140">
<img src="lwac_image_header_s.png" width="150" height="140">
<img src="lwac_image_header_so.png" width="150" height="140">
</li>
OR
<div class="liknoaccordion_header">
<img src="lwac_image_header.png" width="150" height="140">
<img src="lwac_image_header_o.png" width="150" height="140">
<img src="lwac_image_header_s.png" width="150" height="140">
<img src="lwac_image_header_so.png" width="150" height="140">
</div>
OR (both image and text)
<div class="liknoaccordion_header">
<img src="lwac_image_header.png" width="150" height="140">
<img src="lwac_image_header_o.png" width="150" height="140">
<img src="lwac_image_header_s.png" width="150" height="140">
<img src="lwac_image_header_so.png" width="150" height="140">
Header Text here...
</div>

See also
Header Source options
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Body Source options
This is where these options are located:

Read more for these options on how to specify the content of a pane body:
Embedded
Image
AJAX
External Site

5.2.3.1

Embedded
Add the content of the pane body directly into the "Text/HTML" property.
You can either add simple text to be displayed, or more complex HTML code.
Notes:
- The paths of any files (images, etc.) used inside the HTML should be relative to the location of the
web page that shows the accordion. read more
- For the Preview Panel to be able to show images using Site_Root-relative paths (example:
"/image1.gif") or Page-relative paths (example: "image1.gif" or "pics/image1.gif"), you need to add
them to the "Project Assets" folder or to any other local folder that you specify through the Image
Folders for Preview Panel list in Preview Panel Settings.
See also
How do I display a YouTube video in an accordion pane?
Body Source options

5.2.3.2

Image
The content of the pane body is an image.
You can also specify a different image to show on the 4 different states:
"Pane Closed" state
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"Pane Closed - Mouse Over" state
"Pane Open" state
"Pane Open - Mouse Over" state
The image can be sourced either from the project's "Assets" folder, the application "Gallery" folder or a
web location (relative or absolute to the loaded page).
See also
Body Source options
5.2.3.3

AJAX
The content of the pane body is contained in a page that is located in your domain and does NOT have
JavaScript code. AJAX does not allow calling content (HTML) from a page outside your domain. Add
the path/name of the file in the "Page Link" property.
Examples:

ajax1.php
ajax2.htm
/ajaxpages/ajax1.php

Notes:
- The path of the page should be relative to the location of the web page that shows the
accordion.
- The entered page should be present on your website, the Preview cannot show it!
- You cannot use absolute URLs, such as http:// or https://, choose the "External" option
for this.

See also
Body Source options
5.2.3.4

External
The content of the pane body is an external site (e.g. Google) or page.
Add the URL of the site you want to be displayed at the "Page Link" property.
Example:

http://www.google.com

See also
Body Source options

5.2.4

Positioning
Specify where the accordion (i.e. its container) will be placed inside your page.
There are 2 different types of accordions, based on their positioning method:
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- “Embedded” accordions, which occupy page area and push other page elements.
- “Floating” accordions, which “float over” the page and do not push any page elements.

Embedded Accordion
When the accordion is "embedded" in page, you can either insert the accordion inside a page
element (usually a DIV) or have the accordion replace this page element (this means that you only
use this element as a placeholder).
You can also use an image as a placeholder (sometimes this is easier, like in blogs or CMS platforms
where you may not be able to add DIVs in your page HTML).

Floating Accordion
When the accordion is "floating" over page, you can position the accordion relative to the browser's
Window or relative to an Element or Image that exists in the page.
The "Z-Index" property of a "floating" accordion specifies the stack order of the accordion panes (if
they show 'in front' or 'behind' other page elements). By default, the accordion is assigned a large
Z-Index value (500) so that no other page element shows in front of it. If a page element is assigned a
Z-Index value greater than the accordion's value then the accordion will show behind this element.
Also, "floating" accordions can be "drifty". This means that you can choose whether the accordion
moves relevantly when the user scrolls the page or not.

5.3

"Project Style" Properties

5.3.1

Accordion Behavior
Choose whether the panes of the accordion will behave as independent or co-dependent.
- Independent panes means that any number of panes can be open at any time.
- Co-dependent panes means that only 1 pane of the accordion can be open at any time, so when
a pane opens then the currently open pane will have to close. You may also choose to allow the
user to have all panes closed.

See also
Initial Open Panes
Pane Orientation

5.3.2

Initial Open Panes
Choose which pane ('header' and its 'body') of the accordion shows as selected when the page loads.
Method 1: Specify this inside the project (through the interface)
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Just enter the "order" of the selected pane here:

Please note the the application's "Preview" will not necessarily show that pane as open, as it uses
your selected pane in "Project Panes (F2) - Content" instead. This is done on purpose so that you
are facilitated in previewing your currently selected item when editing it. Obviously, your online page
will respect the "Initial Open Panes" value.
You may also use the following option for those users that revisit the same accordion:

In that case, these users will see the accordion panes at the state they left them during their
previous visit. This means that the "Initial Open Panes" value will not have any effect if the user had
changed the accordion open/closed panes in the previous visit.
You may also choose a "random" pane to show as initially selected:

Other methods that specify the initially selected pane externally (overrides the project value):
Method 2: Use a javascript variable in the page that contains the accordion
In the HTML code of your page add the following code:
<script>var projectcompiledname_selected_pane=3;</script>
where:
projectcompiledname is the compiled name of your accordion
3 is the order of pane that should be initially selected (3rd pane in this example)
For example, for this project...

...the proper code for showing the 3rd pane is the following:
<script>var my_accordion_control_selected_pane=3;</script>
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Notes on "Method 2" (variable in page):
- if you use "0" for the variable value, the accordion will appear with all its panes open.
- if you use "-1" for the variable value, the accordion will appear with all its panes closed.

Method 3: Use a special anchor in the URL that opens the page
Open the page that contains the accordion control using a special "anchor" on its URL:
http://www.mysite.com/mypage.html#projectcompiledname_3
For example, for this project...

...the URL for showing the 3rd accordion is the following:
http://www.mysite.com/mypage.html#my_accordion_control_3
Notes on "Method 3" (anchor in URL):
- this works only when the page is opened by a link from another page, not from the same page
(because most browsers do not refresh the page when the link is from the same page).
- if you use "0" for the pane number, the accordion will appear with all its panes open.
- if you use "-1" for the pane number, the accordion will appear with all its panes closed.
- you can also add multiple anchors in the same URL! This is useful if you have multiple
accordions in the same page and you want to specify their initially selected pane (for each
accordion separately).
Example:
http://www.mysite.com/mypage.html#my_accordion_control_3#second_accordion_control_5#thir
d_accordion_control_2
- you can even add multiple anchors in the same URL to specify initial parameters for other Likno
controls that exist in the same page, such as tabs, modal windows, etc.!
Example:
http://www.mysite.com/mypage.html#my_accordion_control_3#my_tab_control_3#my_modal_wi
ndow_1
(for more info on their usage read the respective Help section of Likno Web Tabs Builder, Likno
Web Modal Windows Builder, etc.)
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See also
Accordion Behavior
Pane Orientation

5.3.3

Pane Orientation
Choose whether the panes of the accordion open vertically or horizontally.
Also, if the Header of each pane is placed before or after the Body of that pane (the same rule applies
for all panes in the same accordion).

See also
Accordion Behavior
Initial Open Panes

5.3.4

Panes Show/Hide - How
Choose a show effect for the pane bodies of your project, along with its duration in milliseconds (ms).
See also
Panes Show/Hide - When
Play Panes

5.3.5

Panes Show/Hide - When
Choose if the pane bodies show when the mouse is "over" their headers or when you "click" on them.
Also, if this action ("mouse click" / "mouse over") applies on the entire area of headers or their
"Indicator image only". Note that if you choose the "Indicator Image only" value, you should make sure
that you also have the "Use Indicator" option in Pane Headers enabled.

About the Also "Show All/Hide All" through external page links option:
This option allows you to add special HTML links in your web page, so that your visitors can "Show
All" (or "Hide All") accordion panes at will (also known as "Expand All / Collapse All" functionality).
Note that this option cannot be available when the panes are “co-dependent”, because in such
case only 1 pane can be open at any time. If you want to change from "co-dependent" panes to
"independent" panes you must edit the “Accordion Behavior” property.
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View a full implementation of this feature at "Example 11 (show hide all)" (Preview and Sample
Code):

(note: sample links are not shown in Preview or Sample Code of other projects when enabling this
option; only "Example 11 (show hide all)" shows them there)
How does this feature work?
First, enable (check) this option.
Then, position any of the following HTML links anywhere you like in your web page:

· <a href="javascript:void(0);" class="likno_accordion_generic_
© 2000-2014 Likno Software, all rights reserved
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showAll">Show All</a>
Clicking on the above link shows all panes.

· <a href="javascript:void(0);" class="likno_accordion_generic_
hideAll">Hide All</a>
Clicking on the above link hides all panes.

· <a href="javascript:void(0);" class="likno_accordion_generic_
toggleAll">Show All/Hide All</a>
Clicking on the above link shows or hides all panes (toggle).
Especially for the "toggleAll" case you may also use any of the following optional code
(anywhere in page) in order to specify different content for four different states:
<script>
var likno_accordion_project1_toggleAll_HTML_show
All";
var likno_accordion_project1_toggleAll_HTML_show_over
All</b>";
var likno_accordion_project1_toggleAll_HTML_hide
All";
var likno_accordion_project1_toggleAll_HTML_hide_over
All</b>";
</script>

= "Show
= "<b>Show
= "Hide
= "<b>Hide

Some important rules:
- All links above are optional. You can use only the ones that are related to the functions that you
want. For example, you may want to use only the "toggleAll" link, and not the "showAll" or "hideAll"
ones.
- If you have more than one accordion controls using this option in the same page, then you
must change the "_generic_" part in the filenames to the "compiled javascript project" name of the
related accordion. For example, for this accordion project...

...you should use the following names:
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likno_accordion_project1_showAll
likno_accordion_project1_hideAll
likno_accordion_project1_toggleAll
(similarly with the optional variables)
likno_accordion_project1_toggleAll_HTML_show
likno_accordion_project1_toggleAll_HTML_show_over
likno_accordion_project1_toggleAll_HTML_hide
likno_accordion_project1_toggleAll_HTML_hide_over
You should do this only if you have multiple accordion controls in the same page, otherwise don't
bother as the "generic" name will work for any accordion no matter its name.
See also
Panes Show/Hide - How
Play Panes

5.3.6

Play Panes
Choose if the accordion behaves as a "slideshow", meaning that its panes open automatically (one at
a time) after some seconds.
The first pane that opens is whichever you choose at the Initial Open Panes property. If "None" is
selected there, then the "slideshow" opens the 1st pane in the accordion and continues from there.
If the Accordion Behavior is set to "Panes are independent" then the "slideshow" switches the state of
the focused pane from "close" to "open" (or vice versa) and continues to the next one.
Some options you can use:
- When the user puts the mouse over the accordion area the "slideshow" can pause.
- By increasing the "Delay" you can make your panes show longer before they close for their next
pane to open.
- Through the "Direction" property you can make your panes open in "random" order or even in
"reverse" order (going backwards).
- Through the "Loop" property you can make the "slideshow" start over when the final pane is
reached (or vice versa if "Direction" is "Reverse"). Obviously this option has no effect if the
"Direction" is set to "Random".
The "Example 03 (play panes)" project uses this feature, so you can check it there:
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The "Play Panes" feature is also enabled in the "Example 05L (image)" and "Example 12L" projects.

About the "Play/pause/navigate" through external page buttons option:
This option allows you to add some specially named images (buttons) in your web page, so that
your visitors can use them to "play", "pause" or navigate the accordion panes at will.
View a full implementation of this feature at "Example 12L" (Preview and Sample Code):
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(note: sample buttons are not shown in Preview or Sample Code of other projects when enabling
this option; only "Example 12L" shows them there)
How does this feature work?
First, enable (check) this option.
Then, position any images that have the following names, anywhere you like in your web page:
· likno_accordion_generic_BUTTONID_play.png
This image functions as the "play/pause" button. Note that for this function you need to put 3
more images in the same online folder, but NOT in the page (only the "play" image should
be positioned in the actual page):
likno_accordion_generic_BUTTONID_play_over.png
likno_accordion_generic_BUTTONID_pause.png
likno_accordion_generic_BUTTONID_pause_over.png

· likno_accordion_generic_BUTTONID_previous.png
This image functions as the "previous" button. Note that for this function you need to put 1
more image in the same online folder, but NOT in the page:
likno_accordion_generic_BUTTONID_previous_over.png

· likno_accordion_generic_BUTTONID_next.png
This image functions as the "next" button. Note that for this function you need to put 1 more
image in the same online folder, but NOT in the page:
likno_accordion_generic_BUTTONID_next_over.png
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· likno_accordion_generic_BUTTONID_first.png
This image functions as the "first" button. Note that for this function you need to put 1 more
image in the same online folder, but NOT in the page:
likno_accordion_generic_BUTTONID_first_over.png

· likno_accordion_generic_BUTTONID_last.png
This image functions as the "last" button. Note that for this function you need to put 1 more
image in the same online folder, but NOT in the page:
likno_accordion_generic_BUTTONID_last_over.png

Some important rules:
- The "_BUTTONIND_" part in the filenames can be anything you like (or nothing), the rest should
remain as is, otherwise the accordion cannot map these images to the related functions ("play",
"previous" etc.).
- All images above are optional. You can use only the ones that are related to the functions that
you want. For example, you may want to use only the "play/pause" images and not the "previous",
"next" ones.
- All images should be in "png", "gif" or "jpg" format.
- If you have more than one accordion controls using this option in the same page, then you
must change the "_generic_" part in the filenames to the "compiled javascript project" name of the
related accordion. For example, for this accordion project...

...you should use the following names:
likno_accordion_project1_BUTTONID_play.png
likno_accordion_project1_BUTTONID_play_over.png
likno_accordion_project1_BUTTONID_pause.png
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likno_accordion_project1_BUTTONID_pause_over.png
...etc.
You should do this only if you have multiple accordion controls in the same page, otherwise don't
bother as the "generic" name will work for any accordion no matter its name.
You will find buttons that meet all above specifications at the following installation folder:

Just grab them from there and put them online OR you can create your own buttons according
to the specifications explained above.
See also
Initial Open Panes
Panes Show/Hide - How
Panes Show/Hide - When

5.3.7

Accordion Container (Width/Height/CSS)
Specify the size (width/height) and CSS (colors, formatting, etc.) of the "accordion container".
This container is the element that contains the entire accordion (all its panes).

Width property
If you use "Auto" for Width, the container will use all available width within its parent element. For
example the page width, or a table cell width, or a div width, depending on who is its parent
element.

Height property
© 2000-2014 Likno Software, all rights reserved
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If you use "Auto" for Height, the container will use the height of the content of its bodies (different
for each pane OR the same based on the highest one).

CSS property
This property affects the appearance of the entire accordion. You can specify the style of the
container (i.e. the accordion), using pure CSS code. For more information about CSS styling, visit
http://www.likno.com/cssref
Note about the 'width' CSS parameter: Contrary to other CSS properties, do not use the 'width'
parameter inside the Container CSS as there are separate Width/Height properties (see above) for
this purpose.
See also
Panes (Width/Height/CSS)

5.3.8

Panes (Width/Height/CSS)
Specify the size (width/height) and CSS (colors, formatting, etc.) of the "panes" that comprise the
accordion control.

Width property
If you use "Auto" for Width, the pane will use all available width within its "parent" element. This
"parent" element is the accordion container, unless this "accordion container" is "disabled" (in
which case the "parent" element is the page element that contains the pane).

Height property
If you use "Auto" for Height, the pane's height will be determined by the height of its header and
body (based on content there). You can then choose each pane to use its own height OR use the
largest one to make all panes have the same height.

CSS property
This property affects the appearance of panes on the accordion. You can specify the style of
panes, using pure CSS code. For more information about CSS styling, visit
http://www.likno.com/cssref
Note about the 'width' CSS parameter: Contrary to other CSS properties, do not use the 'width'
parameter inside the CSS property as there are separate Width/Height properties (see above) for
this purpose.

Resizable property
This applies only when the panes are of vertical orientation.
When checked, the user can resize any pane by placing the mouse at its bottom border and
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dragging it.

See also
Accordion Container

5.3.9

Pane Headers
Specify the style of Headers, using pure CSS code and/or "Background/Indicator" Sets.
For more information about CSS styling, visit http://www.likno.com/cssref
These properties affect the appearance of the "Pane Headers".
Pane Header:
(the "title" that functions as the selector of its pane)

Pane Headers Common CSS
Through the Pane Headers Common CSS, you can specify most settings for the appearance of
all your Headers.
For example, "Example 01" uses the following "Common CSS":
font-family: Tahoma, Verdana, Arial, Helvetica, sans-serif;
font-size: 11px;
text-align: center;
padding: 10px 15px 10px 15px;
font-weight: normal;
background-color: #bfdbff;
color: #000066;
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cursor: pointer;
Some notes:
- Use width: auto; (or skip this parameter) for automatic width based on header's content.
- The same applies for height (height: auto; or skip this parameter).
- A padding value like padding: 10px; provides a "minimum" space around the header's content
and its borders (shows as green below).

- These values are combined with the "Extra CSS" values for each different state (see below).

Pane Headers Extra CSS
These are extra CSS values that supplement or override the "Pane Headers Common CSS"
values, so that headers can differentiate their appearance on their 4 different states:
Pane Closed state:

Pane Closed - Mouse Over state:

Pane Open state:
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Pane Open - Mouse Over state:

For example, "Example 01" uses the following "Extra CSS" values:
Pane Closed state: (no extra CSS, just uses the common CSS values)
Pane Closed - Mouse Over state: (values differ from the common CSS ones)
background-color: #8CB2E2;
color: #FFFFFF;
font-weight: bold;
Pane Open state: (values differ from the common CSS ones)
background-color: #e3efff;
font-weight: bold;
Pane Open - Mouse Over state: (values differ from the common CSS ones)
background-color: #8CB2E2;
color: #FFFFFF;
font-weight: bold;
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Pane Headers Separator CSS
A pane can act as a separator between its adjacent panes, when the following option is used in
"Project Panes" for its header:

A separator does not have any "mouse over/click" effects, neither "body content", as it is there to
provide separation or "title" support.
For example in "Example 01", if you make "Pane_2" a separator you will get a "separating area"
like this:

Through the "Pane Headers Separator CSS", your "separator" headers can differentiate their
appearance from "normal" headers.

About the 'width' parameter:
Contrary to the "Accordion Container CSS" or "Pane Container CSS" properties, you need to use
the 'width' parameter inside the Header CSS properties as there are no separate Width/Height
properties for this purpose. If you want the width to be determined automatically and match the
Header's content width, just use width:auto; or do not use the 'width' parameter at all.
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About the "Background Set" and "Indicator Set":
A "Background Set" is a set of images that covers the background of all accordion Headers. Similarly,
the "Indicator Set" is a set of images that puts an "indicator image" on the header, one for each state
(optionally).
For example, the example project "ExamplePack01-01", uses the following sets:

For more information on how these sets are structured, please read the "Background/Indicator" Sets
topic.

See also
Accordion Container
Panes (Width/Height/CSS)
Body CSS
"Background/Indicator" Sets

5.3.10 Pane Bodies
Specify the style of the bodies, using pure CSS code.
For more information about CSS styling, visit http://www.likno.com/cssref
Note about width: Contrary to the Container CSS property, you need to use the 'width' papameter
inside the Body CSS properties as there are no separate Width/Height properties for this purpose. If
you want the width to be determined automatically and match the container's width, just use
width:auto; or do not use the 'width' parameter at all.
See also
Accordion Container
Panes (Width/Height/CSS)
Headers CSS
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6

How Do I...

6.1

Find my INSTALLATION ID
In order to activate your license you need to login to your Likno User Area and provide us with the
unique Installation ID of your current installation.
Your Installation ID can be found at the "Help -> Enter Activation Code" option of the application
menu.

6.2

Purchase/Activate
Step 1. Purchase
· Access the online registration page located at http://www.likno.com/jquery-accordion/purchase.php
· Click on your preferred method of payment and enter the necessary info in the order form
You will soon receive an e-mail containing instructions on how to get the Activation Code to use it in
your installation.
Step 2. Activate your Installation
· Choose the "Help -> Enter Activation Code" menu option in the application
· Enter your Activation Code
You will need to have "Full Admin rights", read how here.
Following these simple steps you will be a registered user and you will be able to take full advantage
of the Likno Web Accordion Builder features.

Methods of payment
There are many flexible payment options:
·
·
·
·
·

Credit Card Orders (all major credit cards accepted)
Phone Orders (toll-free)
Mail Orders (pay by check)
Fax Orders
Purchase Orders

All on-line transactions are protected by an extremely high level of encryption, the highest allowed by
law.

6.3

Use effects when an accordion pane shows or hides
Change the Panes Show/Hide - How property under the "Style Editor" tab.
See also
Panes Show/Hide - How
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Change the position where the accordion is located on page
Change the Positioning property under the "Project Panes" tab.
See also
Positioning

6.5

Load with AJAX the content of a pane body
You might need to load the content of one of your accordion pane bodies from another file in your
server at the time you display that pane. In that case you need to use the AJAX technique in order to
load a remote HTML file and inject its contents into the DOM.
This technique is included into the application, and the only thing you need to do is to select the "AJAX
" value in the <Body Source> property under the "Project Panes (F2)" panel, and then define the path
and name of the file that you want to display, through the <Page Link> property below.
Note! Due to security issues you are not allowed to enter an absolute path as the value of the call
property. You can only call a file that resides within your site by using a relative path.
See also
Body Source options
Body Source: AJAX

6.6

Load an external site as the content of a pane
You might need to load a full site as the content of one of your accordion panes (inside its body).
In that case you have to select the "External Site" value in the <Body Source> property under the
"Project Panes (F2)" tab, and then define the URL of the site that you want to display in the <Page
Link> property below.
See also
Body Source options
Body Source: External

6.7

Use multiple accordion projects in the same page
There is no restriction in the number of accordion projects you can use in the same page.
You only need to specify a different name for the "Compiled JavaScript Project" (default:
likno_accordion_project.js) inside the Project Properties pane and make sure that you link all different
projects to your page.
Note! It is very important that different accordion projects are using different page elements for their
positioning. You cannot associate the same page element with two different accordion projects!
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Also read Troubleshooting on common errors about multiple projects.

6.8

Properly use paths in the "Website Folder" option
Contrary to the "Project Assets" option, this property is free text as you may need to enter both the
path and the filename of the website image.
You can use paths to the image file in 3 different ways:
"Absolute" paths:
· http://www.likno.com/jquery-accordion/assets-app/close.gif
· http://www.mysite.com/pics/image1.gif
· https://www.google.com/image2.gif

"Document-relative" paths:
(image folder is relative to the folder of the loaded page that shows the accordion)
· close.gif
· pics/close.gif
· ../close2.gif

"Site_Root-relative" paths:
(image folder is relative to the Site Root folder)
· /close.gif
· /pics/close.gif
· /close2.gif

Note: For the Preview Panel to be able to show images using Site_Root-relative paths (example:
"/image1.gif") or Page-relative paths (example: "image1.gif" or "pics/image1.gif"), you need to add
them to the "Project Assets" folder or to any other local folder that you specify through the Image
Folders for Preview Panel list in Preview Panel Settings.
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Display a video/movie in an accordion pane?
You can load and display a video/movie inside a pane body.
Open "Example 07 (video)" inside the application to see this functionality.
How is this setup?
Copy the video's "embed code" from YouTube (for example) and paste it into the "Text/HTML"
property of the Body Embedded option, inside the "Project Panes" tab.

You can also change the Accordion Container (Width/Height/CSS) or Panes (Width/Height/CSS)
properties in "Style Editor" tab, to fit the width and height of the video and avoid scrollbars (or just use
"auto" there).
To show your own video, just replace the "<object>" section with its respective embed code.
Example:
<object width="400" height="243">
<param name="movie"
value="http://www.youtube.com/v/teMlv3ripSM&color1=0xb1b1b1&color2=0xcfcfcf&
hl=en_US&feature=player_embedded&fs=1"></param>
<param name="allowFullScreen" value="true"></param>
<param name="allowScriptAccess" value="always"></param>
<embed
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src="http://www.youtube.com/v/teMlv3ripSM&color1=0xb1b1b1&color2=0xcfcfcf&hl
=en_US&feature=player_embedded&fs=1" type="application/x-shockwave-flash"
allowfullscreen="true" allowScriptAccess="always" width="400"
height="243"></embed>
</object>
Exactly the same would apply for other movie types, such as Flash movies.
Note: If you want to support IE6 (which is dropped by YouTube), you need to add the following
parameter inside the embed code that you take from YouTube:
<param name="flashvars"
value="fmt_url_map=34%7Chttp%3A%2F%2Fv12.lscache5.c.youtube.com%2Fvideo
playback"></param>

6.10

Use the "background-image" value in CSS properties
The following is an example of CSS that applies a background image to the accordion through the
background-image value:
font-family: Segoe UI, Tahoma, Verdana, Arial, Helvetica, sans-serif;
font-size: 11px;
text-align: left;
padding: 10px 15px 10px 15px;
font-weight: normal;
cursor: pointer;
color: #3f3f3f;
background-image: url(example03headerbg.jpg);
background-repeat: repeat-x;
background-position: top;

1. Location of the image
The project needs to know where to find this image, otherwise it will not be displayed in the Preview
Panel and will not be compiled either.
You should put this image inside the project's "Assets" folder, which is a subfolder at the folder where
the project is located.
To demonstrate this, just open the "Example 03.lwac"...
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... go to the "Style Editor tab...

...and edit the "Pane Headers Common CSS" value:

There you will find the CSS mentioned in the beginning, that uses the background-image:
url(example03headerbg.jpg); value.
Now, open the "assets" folder of this example, which should be at:
C:\Program Files\Likno Web Accordion Builder\Examples\Example 03-assets
(the installation path may be different in your computer)
There you will find the image file example03headerbg.jpg.
If that image wasn't there, the background could not appear.
So, if you ever use a background image in your CSS, make sure that you copy this image at the
project asset's folder first, otherwise the image cannot be used by the compiled project.

2. Adjusting the width/height of the Container and "background-image"
considerations
When a accordion uses a "background-image" on its Accordion Container CSS (or other CSS
properties), this image can either "repeat" itself (tiles within the background) or "no-repeat" (shows
as is, once).
This is determined by the "background-repeat" CSS value:
background-repeat: no-repeat;
OR
background-repeat: repeat;
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OR
no existence of this property, which defaults to "background-repeat: repeat;"
Why is this important?
1. When the "no-repeat" value is used, the control may not show properly when you change the
size ("Width" or "Height") of the Container. To show the control properly when making the
Container bigger or smaller, you need to also resize the background image with an image
editor.
2. This is not the case when the "repeat" value is used (or no value is used at all). Since the image
tiles and acts as a "texture", no image resizing is required when changing the Container size.

Tip on "texture" images:
AllWebMenus has plenty of textures you can copy and use as background images:

6.11

Use a "Background Set" (or "Indicator Set" respectively)
A "Background Set" is a set of images that fill the background of all pane Headers in the accordion.
It consists of a "thumbnail" image which defines the set...
name_backgroundset.jpg
...and up to 15 images, that cover specific areas of the Header background for specific header "states"
(closed, closed over, open, open over, separator):
name_backgroundset_closed_left.png
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name_backgroundset_closed_tile.png
name_backgroundset_closed_right.png
name_backgroundset_closed_over_left.png
name_backgroundset_closed_over_tile.png
name_backgroundset_closed_over_right.png
name_backgroundset_open_left.png
name_backgroundset_open_tile.png
name_backgroundset_open_right.png
name_backgroundset_open_over_left.png
name_backgroundset_open_over_tile.png
name_backgroundset_open_over_right.png
name_backgroundset_separator_left.png
name_backgroundset_separator_tile.png
name_backgroundset_separator_right.png
The name_ part in all filenames identifies the set, so each different set uses a different name there.
This is the only filename part that can be changed. The rest of the filename should NOT be changed,
your images should use the syntax as shown above because each word is used by the javascript to
place the image at the respective positioning in the background.
You can view full background sets at the assets folder of most "Example Pack" examples, like
"ExamplePack01-01":

Example:
Let's assume the following images for the "closed" header state of a set called myset:

myset_backgroundset_closed_left.png

myset_backgroundset_closed_right.png
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myset_backgroundset_closed_tile.png
This is how the background of header shows, depending on which images exist in the set or not
(disregard the red border):
When the Background Set has all 3 image files (most common case):

When the Background Set has only the "myset_backgroundset_closed_left.png" image file:

When the Background Set has only the "myset_backgroundset_closed_right.png" image file:

When the Background Set has only the "myset_backgroundset_closed_tile.png" image file (tiles in
the entire background):

When the Background Set has only the "myset_backgroundset_closed_left.png" and the "myset
_backgroundset_closed_right.png" image files:

The following rules apply:
· The first image in the list above (name_backgroundset.jpg) is just the preview thumbnail of the
set. It does not appear anywhere in the header's background when applied, but it is necessary for
the user to preview the set and select it when browsing for Background Sets. So every set should
always contain such an image otherwise the set will not be visible (available) for selection! This
thumbnail image should be strictly in .jpg format, the rest of images can be in any format.
· You can also create your own sets! Apart from the sets provided by Likno Software, which are
contained in the "Gallery" application folder (and should never be edited there!), you can create and
add your own sets inside any other folder in your hard drive. Just use the syntax described above for
the filenames of all images of the set. You can then go to the "Custom Folder" tab, choose that
folder and browse your custom sets located there (you actually browse the special "thumbnail"
images that you created for each set). Or, you can directly add your set of images into the "Project
Assets" folder of your project and select it from there.
· Your set is not required to have all 16 image files shown above. Only the "name_backgroundset.jpg"
image is absolutely required, all other images are optional. In other words, you may omit any image
that you do not need in your background design. For example, projects "ExamplePack01-07" and
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"ExamplePack01-09" use sets that have only "_tile" images. No "_left" or "_right" images exist for
those sets. Just browse their "Project Assets" folder ("C:\Program Files\Likno Web Accordion
Builder\Examples\ExamplePack01-07-assets", etc.) and you will see that they use less than 16
images for their background.

About "Indicator Set"
Similarly, an "Indicator Set" is a set of images that act as an "indicator" on the pane Headers of the
accordion.

It consists of a "thumbnail" image which defines the set...
name_indicatorset.png
...and up to 4 images, that act as the "indicator" for each different header "state" (closed, closed over,
open, open over):
name_indicatorset_closed.png
name_indicatorset_closed_over.png
name_indicatorset_open.png
name_indicatorset_open_over.png
You can view full indicator sets at the assets folder of most "Example Pack" examples, like
"ExamplePack01-01":
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Similarly to the "Background Sets", the following rules apply:
· The first image in the list above (name_indicatorset.png) is just the preview thumbnail of the set.
It does not appear anywhere in the header's background when applied, but it is necessary for the
user to preview the set and select it when browsing for Indicator Sets. So every set should always
contain such an image otherwise the set will not be visible (available) for selection! This thumbnail
image should be strictly in .png format (with transparency on edges), the rest of images can be in
any format (but transparent png is strongly recommended).
· You can also create your own sets! Apart from the sets provided by Likno Software, which are
contained in the "Gallery" application folder (and should never be edited there!), you can create and
add your own sets inside any other folder in your hard drive. Just use the syntax described above for
the filenames of all images of the set. You can then go to the "Custom Folder" tab, choose that
folder and browse your custom sets located there (you actually browse the special "thumbnail"
images that you created for each set). Or, you can directly add your set of images into the "Project
Assets" folder of your project and select it from there.
· Your set is not required to have all 5 image files shown above. Only the "name_indicatorset.png"
image is absolutely required, all other images are optional. In other words, you may omit the image
for a state that you do not need an indicator there.

See also
Pane Headers
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7

What is...

7.1

The HTML Linking Code
This is the code added in the HTML of the page during the linking process in order to link the
necessary files to your page.
This section looks like the following one (yours may be slightly different):
<!-- ******** BEGIN LIKNO WEB ACCORDION CODE FOR likno_accordion_project ******** -->
<script type="text/javascript">var lwacLinkedBy="LiknoWebAccordion
[1]",lwacName="likno_accordion_project",lwacBN="100";</script><script charset="UTF-8"
src="likno-scripts/likno_accordion_project.js" type="text/javascript"></script>
<!-- ******** END LIKNO WEB ACCORDION CODE FOR likno_accordion_project ******** -->
Note: You may need to adjust the "src" path (highlighted), so that your page links to the "js" file
correctly.

7.2

The Internet Explorer Information Bar Warning
When you preview a local web page in Internet Explorer (IE6 XP SP2 +, IE7) that contains javascript
(like our scripts do), you will get the following message:
[To help protect your security, Internet Explorer has restricted this webpage from running scripts or
ActiveX controls that could access your computer. Click here for options... ]

This is not a problem, as the "security" warning never appears online on your actual pages. It is
not only related to Likno Software products but to all javascripts running on your pages locally.
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This default behavior of Internet Explorer only happens when viewing pages saved to the local
computer and only in Internet Explorer.
This does not happen when pages have been uploaded to a web server and are then viewed online.
To overpass this Internet Explorer warning, you can click on the message bar and select "Allow
Blocked Content":

Then, a warning dialog will appear and you can just press "Yes" for the web page to properly load all
the javascript related files:
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(do not worry about the warning, our scripts are 100% safe)
You can read more about the IE Information bar at:
http://support.microsoft.com/kb/843017 (Windows XP)
http://windowshelp.microsoft.com/Windows/en-US/Help/91b1038d-3f53-43a3-8bd8-9551e7c0b7c6103
3.mspx (Windows Vista)

7.3

The "Colors detected in this CSS" feature
This feature allows you to change a color in a CSS property, by using an advanced Color Picker
control instead of typing its HEX code.
How does this work?
When you edit any CSS property, the application tries to detect the colors that the CSS text is using, by
detecting their HEX code:
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Note that only the 3-digit or 6-digit HEX syntax (starting with a #) can be detected by the Color Picker
control, such as:
color: #0000FF;
The following (valid) color syntaxes are not detected for easy editing (but are still functional as CSS
values):
color: blue;
color: rgb(0,0,255);
color: rgb(0%,0%,100%);

7.4

The "Relative paths detected in this HTML" feature
This feature detects all "relative" (not absolute) paths used by resources (images, files, etc.) inside the
"Embedded" Header or Body HTML, so that you check if these point to the correct location relative to
the online page that contains the accordion.
For example, let's assume that you have the following website structure...
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...and that the "page_with_control.html" is the page where your accordion control is added.
If you want to show "image2.png" in the accordion, this is how its "Embedded HTML" should look like:
<div style='padding: 21px 0 20px 17px; line-height: 14px;'>
<img src="images/image2.png" width="32" height="32" border="0"
style="margin: -2px 8px 15px 0; float: left;"/>
Text here, next to the image...
</div>
OR src="/images/image2.png" but NOT src="image2.png".
Why?
Because, the compiled accordion seeks "relative" resources (images, files, etc. that use "relative"
paths in the "Embedded HTML") based on the page that shows it. And in this example the image is
located in a subfolder of where the page is located.
As a "worry-free" alternative you can use "absolute" paths, like
http://www.likno.com/images/image2.png.

Note for the Preview Panel only: For the Preview Panel to be able to show images using
Site_Root-relative paths (example: "/image1.gif") or Page-relative paths (example: "image1.gif" or
"pics/image1.gif"), you need to add them to the "Project Assets" folder or to any other local folder that
you specify through the Image Folders for Preview Panel list in Preview Panel Settings.
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8

FAQ and Tips

8.1

Troubleshooting
This is a collection of quick tips to avoid trouble.
Note: An Online Knowledge Base is also available with more information and up-to-date content.
Please check this knowledge base also.
I added the code in my page but nothing happens.
- Make sure that you have linked the project correctly.
- Make sure that you selected the correct domain before compiling (Project Properties).
- Make sure that you uploaded the likno-scripts directory after you compiled your project.

I added a second Accordion project to my web page and now nothing works properly.
Make sure that the two projects and their options use different names.

Filenames:
· Spaces in the compiled project name are not allowed as they are not parsed properly by some
browsers. As an example, use "main_project.js" or "mainproject.js" instead of "main project.js".
· Avoid using filenames that contain special characters, like quotes ("), apostrophes ('), etc. In most
cases these characters will produce an error.

8.2

"Full Admin rights" and the activation process
In order to activate Likno Web Accordion Builder you need to be an "administrator" on that PC.
Otherwise, the activation process fails.
There are some cases (Windows Vista or 7 mostly) where you might think that you are administrator
but you miss certain rights that are required by the activation process (you may be a "protected
administrator' instead).
To get "full" administrator rights for the activation process,choose "Yes" on the following popup
window:
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(this window appears only for the activation process, you will not see that again after you activate)
If an administrator password is requested and you do not have this, then please contact your
administrator to activate Likno Web Accordion Builder through the administrator account.
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